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Introduction 
In a changing world where we are speaking about a new human revolution, education has to 
evolve at the same pace. When we work with adult learners, it is important that they see the 
usefulness, the necessity and the importance of technological progress. 

Strategies to Digitalise Adult Education aims to provide adult education centres with the skills 
necessary to implement a strategy that allows them to go from analogical, old-fashioned 
techniques to a modern-day approach with the use of the new technologies available to 
educators. 

With a partnership of 7 partners coming from 5 different countries, Strategies to Digitalise Adult 
Education is funded under the Erasmus+ Programme of the European Union, in the Key Action 
2 for development of innovation in adult education. The partnership is comprised of Inercia 
Digital (coordinators, Spain), Sinergia Società Cooperativa Sociale (Italy), Consorzio Lavoro e 
Ambiente (Italy), Akademia Humanistyczno-Ekonomiczna w Lodzi (Poland), Casa Corpului 
Didactic Teleorman (Romania), IES Jacarandá (Spain) and Oltu Public Education Center (Turkey). 

This guide, the main result of the project, covers the training needed for leaders of an adult 
education centre on how to train both their administrative staff and their teachers to plan and 
implement a strategy of digitalisation. 

 

For more information visit the website at https://digitaladulteducation.eu 
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“Communities of practice” – developing strategy of managing the 
technological change within the institution   

Strategies to Digitalise Adult Education   
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Strategy development 
The aim of this training is to help the administrative staff of the centre develop a plan on how 
to digitalise the school. It allows them to identify the current resources they have, and to create 
a reachable scenario where they can take their organisation to. 

By the end of the training, the participants will be able to use several tools to analyse their 
current situation and plan how to digitalise their centre. 
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Session 1: Integration 
Introduction 
A 5-day workshop / training sessions in groups - day 1 

Soft skills trainings are useful for all employees of all levels and are an extremely effective way 
to build an efficient, collaborative work team. 
Training is a great way for managers at all levels to improve their ability to inspire and motivate 
individuals and teams to achieve outstanding results. 
 
These kind of training programs shows how important is: 

 to be a part of the project, 
 to know what its overall goal 
 to know what part of a project we are, 
 to take responsibility for the project 
 to see what is our final product 

These kind of training programs requires the following: 
 searching for innovative ways of developing and managing people. 
 finding new opportunities. 
 preparing for difficulties 
 knowing company's mission, vision, and values 

 
Integration -Training sessions for managers helping to recognize organizational potential of the 
institution. Recognizing participants’ beliefs, intentions and resources as the learners come with 
beliefs about the role of technology in learning which impacts upon the way they use 
technology. 
 
Next assignments are planned for recognizing your co-workers assets, your strengths and 
resources as an institution, and, at last to set the goals that are possible to reach for your team 
in terms of digitalizing education. We propose a sequence of exercises that were run as a 
strategy training for managers in Lodz, January 2019: 
 
Start your training welcoming participants, introducing them to the goals of the training. Some 
nice exercises, commonly known as Ice-breakers create a good atmosphere and help to work 
on different issues.  
 
 
Our approach to changing classroom dynamics for the use of ICT has an impact on the 
effectiveness in supporting the development of ICT technology. Managers will be most 
successful when they try to develop strategies, beginning with answers to the questions: 

 do I have clear reasons as well as a plan for using the technology? 
 are trainers able to encourage learner's autonomy (through managing activities, 

extending activities, discussion and reducing tutor presentation time)? 
 
Building strategy consists of training sessions in groups. It is necessary to have 5 sessions. 
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Methodology 
Session is face-to-face with an approximate duration of 3,5 hours. Approach should be as 
practical as possible. Methodology of the training is work in groups. 
 
Tasks for the workshop aim to prepare the answers for the questions:  

 What do we have? - knowing the resources of the institution and how to use them (make 
them useful) 

 What do we want to do? 
 What do we need in addition to what we already have? 
 Where can we get it? 
 How can we cooperate? 

 
After completing the set of tasks and analyzing them an action plan can be developed. 
Methods: group work, brainstorming, discussion, debate on why new technologies should be 
implemented in the institution, team building and strategy games. 
 

Learning objectives 
 To understand how to develop your confidence in managing and integrating ICT in 

your institution  

 To know what kind of actions are necessary 

 To prepare way of developing and implementing ICT technology in the institution 
(Action plans) 

 

Learning outcomes 
LO1: learners will know how to organize a structure of co-working team supporting the 
technological change 

LO2: learners will know how to recognise their own potential and the resources of their 
institution 

LO3: a road map of intended activities and the schedule will be designed. New quality of 
participation oriented communication within the institution will be established and 
understanding the needs will be emphasized  
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Activity 1: Joggling items 
 

Joggling items 
Equipment required: Juggling balls, bean bags (or even a rolled up sock). 
Space required: Small. Delivered either indoors or outdoors. 
Group Size: 8 to 14 ideally (however is still works with slightly larger or smaller groups). 
Total Time: 20-30 minutes 
 
Ice breaker game (Joggling items) integration and soft skills training 
 

1. Organise the group into a circle, and set up a juggling system that processes juggling 
balls by throwing them across the circle of team members from one person to the 
next. 

2. When a ball is thrown the thrower must shout the name of the recipient 
3. They catch it and throw to another group member. This continues until each group 

member has caught & thrown the ball just once. (it should have eventually ended back 
at the start point). 

4. Ask each group member to identify who they received the ball from and who they 
threw it to. 

5. Test this out by throwing the ball in the same original order until it arrives back at the 
start point. 

6. The next stage is to introduce more balls and see how many you can get moving round 
the circle in the original order. As many balls as people is extremely difficult. You can 
also add another ball to be sent in reverse order to add a bit confusion to the mix. 
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This is illustration for integration part: Joggling items Good practice (DAE Strategy training in 

Lodz, January, 2019)  

"the training conducted by Inercia Digital opened us to the opportunity to increase the 
infrastructure of our training activities through a Moodle platform; if we started already to use 
some ICT tools for training activities we are not yet structured to organize in an effective way a 
distance learning course. The test on their platform and on the potential in terms of creating 
contents, maintaining contacts with trainees, submitting evaluation tests, etc. was really 
inspiring for us. We also consdered funny and stimulating the experience trough Kahoot, also its 
application to topics that usually are not interesting for the trainees”.  
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Activity 2: Team building game (Tower) 
 

Purpose of the activity: This exercise gives participants first-hand experience of how 
management style affects the performance of a team. It shows different styles in action, 
demonstrating, for example, that what managers intend is not always what comes across. This 
is a chance for participants to think about what makes a great leader, and it provides rich data 
upon which to draw important conclusions about leadership behaviour and its impact. 

1. Divide your participants into groups, each containing one manager and three team 
members. 

2. Give them instructions: As a group, they have to build a tower using the blocks. Sounds 
easy – until you tell them that team members must be blindfolded and use their non-
dominant hand. 

3. Managers cannot touch either the blocks or their team members. 
4. Discuss some of these important messages 

 

 
 
This is illustration for „Tower” game, Good practice (DAE Strategy training in Lodz, January, 

2019)  
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Post-Activity Discussion  
Presentation of the conclusions 

As a team members answer and discuss the questions:  

 What a manager intends is not always what comes across to others. 
 How can managers make a difference by providing a perspective on what the team is 

trying to accomplish? 
 What did you learn about others in your group? 
 What did you learn about how you can influence your team? 
 Did you notice different managerial styles in action? 

 

 

This is illustration for Post-Activity Discussion, Good practice (DAE Strategy training in Lodz, 

January, 2019)  
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Session 2: What opportunities does ICT bring? 
Introduction 
Notes on the choice: A 5-day workshop / work in groups with trainers – day 2 

Tasks for the workshop - Prepare the answers for the questions:  

 What do we have? 
 knowing the resources of the institution and how to use them (make them useful) 
 Both: people and equipment 

 

Methodology 
Session is face-to-face with an approximate duration of 3,5 hours. Interaction between ICT and 
other elements, issues arising from the physical location of technology– do we have enough 
space? 

Methods: group work, brainstorming, discussion. 
Materials: Flip chart, paper, markers. 
 

Learning objectives 
 Recognizing strong and weak sides of the plan 

 Working on weak sides of the digitalization plan  

 To be able to create next strategy steps 

Learning outcomes 
LO1: Managers will be able to define needs in regards to implementation of digitalisation 
strategy  

LO2: Managers will be able to find strong and weak sides of the plan  

LO3: Managers will be able to understand the needs to better implement next strategies steps  
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Activity 1: Nail Balance 
 

Team building game (Nail Balance)  
You are conducting this exercise to help your colleagues to pen up to new ways of thinking, to 
recognise their creative potential. The task seems to be impossible to complete at first glance 
which is similar to many problems we encounter at work. The participants experience the 
moment of „aha!” when they realise that solution is possible though. 
 
Group Size 1 - 5 
Time: 5 - 60 minutes 
To use this activity with larger groups you must first get them into smaller sub 
groups (3-4 people works well). Supply each group with their own Nail Balance set. 
 
The objective is to balance a bunch of nails on the head of a single nail. All of the nails have to 
be balanced at the same time and cannot touch anything but the top of the nail that is stuck in 
the base. 
 

1. Hand each group a piece of wood with a nail hammered into it (see photo) and 8 
nails. 

2. Ask them to balance all the supplied nails on the head of a single nail. Only the 
supplied equipment can be used (no tape, string, glue, etc. allowed). The supplied 
materials may not be altered. Ask the participants not to use mobile devices, as the 
solution is available on the Internet. 

 

 

 

 

 
This is illustration for „Nail balance” game. Good practice (DAE Strategy training in Lodz, 

January, 2019)  
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Activity 2: SWOT analysis 
 
In most cases, SWOT analysis is sufficient for your purposes, but you can additionally apply PEST 
analysis if you want to deepen the insight. 
SWOT analysis is a strategic planning technique used to help a person or organization identify 
strengths, weaknesses, opportunities, and threats related to project planning. It is an incredibly 
simple tool to help organization develop business strategy. 
The name is an acronym for the four parameters the technique examines: SWOT – Strengths, 
Weaknesses, Opportunities, Threats 
Strengths: characteristics of your team and institution that you consider as assets. 
Weaknesses: characteristics of your team and institution that you consider a disadvantage. 
Opportunities: elements in the environment that your team and institution could exploit to its 
advantage. 
Threats: elements in the environment that could cause trouble for the project. 
 
Sources 
Wikipedia (2019) SWOT analysis. Available from https://en.wikipedia.org/wiki/SWOT_analysis 
 
 
Work in groups 
Group work depending on how big your institution is: 
Groups of 4-5 persons or one group in case of smaller organization 
 
Materials: 
Flip chart paper, markers 
Hand each group a big sheet of paper (flip chart paper will do) 
Tasks for the workshop: 
Divide your paper in four parts by drawing horizontal and vertical line. Mark them as: 
 S (strengths), W (weaknesses), O (opportunities), T (threats). 
 
Prepare the answers for the questions and write them down in proper spaces. (see the 
attachment-Annex I). 
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This is illustration for presentation of SWOT , Good practice (DAE Strategy training in Lodz, 

January, 2019)  
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Post-Activity Discussion 
Read and discuss each group's answers. 

The next stage of the analysis is to take the highest ranking strengths, weaknesses, 
opportunities and threats. 

Groups try to answer the following questions: 

1. How do you use your strengths to take advantage of opportunities? 
2. How do you overcome weaknesses preventing you from taking advantage of 

opportunities? 
3. How can your strengths reduce the probability of threats? 
4. What can you do about your weaknesses to make the threats less likely? 

For a SWOT analysis to be effective participants need to be deeply involved. This isn’t a task that 
can be delegated to others. Select people who can represent different aspects of organization. 
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Session 3: Prototyping the strategy 
Introduction 
Notes on the choice: A 5-day workshop / work in groups with trainers – day 3 

Why building strategy is important? 
Strategic planning provides your institutions the opportunity to prioritize goals and action items 
to focus time and resources on key initiatives. 
How to structure strategy training? 
It is very important to work directly with participants of training, get them involved in tasks or 
collect their ideas, so the form of a workshop is recommended. 
Description of goals 
A set of actions and procedures recommended for the institution should be developed as a 
product of the common strategy training for necessary changes and implementation of new 
technologies. Such a package needs to be outlined and endorsed by the whole community of 
the institution. Information about activities for all stakeholders should be planned on each stage 
of the implementation of the new technologies. 
 

Methodology 
Session is face-to-face with an approximate duration of 3,5 hours. To work effectively as a team 
you have to develop cooperation and communication skills. Methods: group work, brainstorming, 
discussion. 
 
 
Learning objectives 

 Developing communication and cooperation skills 

 Recognizing institution's mission, vision, values and goals (VMOSA tool)  

 A better understanding of the strategy 

Learning outcomes 
LO1: Managers will be able to prepare next steps of digitalization strategy 

LO2: Managers will be able to define institution's mission, vision, values and goals  

LO3: Managers will be able to define needs in regards to implementation of digitalization 
strategy 

  



Strategies to Digitalize Adult Education 
2017-1-ES01-KA204-037991 

  
 

The European Commission support for the production of this publication does not constitute an 
endorsement of the contents which reflects the views only of the authors, and the Commission 
cannot be held responsi-ble for any use which may be made of the information contained 
therein 

Activity 1: Zoom 
 
Objective: Problem-Solving, Communication 
Best for (group size): Small or large group 
Time: 30 minutes 
Materials needed: Zoom by Istvan Banyai  
Hand out to each participant one picture from Istvan Banyai’s book, Zoom. Explain that 
participants can only look at their own picture and keep it hidden from others. Participants must 
study their pictures and do their best to describe it to others, as the teams work together to put 
the pictures in the correct sequence. 
This activity focuses on fostering problem-solving skills by pushing participants to work together 
and communicate with one another to achieve the common goal. It also allows for natural 
leaders to emerge and take charge in completing the task most effectively. 
This problem-solving exercise teaches participants to work in a team and demonstrates 
“departmental” working: the concept that each individual contributes to a larger team effort, 
even though their contribution may not always be apparent. The exercise works best when it 
involves participants from multiple organizational departments who perform a variety of roles. 
 
Using Zoom by Istvan Banyai is only an example, you can use similar in the same way. 
 
https://www.smartsheet.com/top-team-building-games-experts-share-their-favorites 
 

 

This is illustration for presentation of Zooms activity summary, good practice (DAE Strategy 

training in Lodz, January, 2019)  
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Activity 2: VMOSA tool 
 

Discuss and decide on specific topics in your institution: 
What is your vision, mission, core values, goals and objectives? 
• Vision 
A vision statement is a mental picture of what you want to achieve. Don’t make it cluttered or 
complicated. A vision statement should be simple enough so you can hold the meaning of it in 
your “mind’s eye”.  
• Mission  
A mission statement defines how you will achieve your vision. It is an action statement and often 
begins with the word “to”.  
Once again it needs to be simple so that you can easily hold the idea in your mind. 
• Core Values 
Core values are standards you place on your business activities. Examples include ethics, 
environmental issues, labour standards, etc.  
In addition to the mission statement you may want to state your goals and objectives for the 
project.  
• Goals 
A goal is a general statement of what you need to achieve to accomplish the vision of your 
business project.  
• Objectives 
An objective is a specific time-sensitive milestone used to measure your progress towards 
achieving your goals and vision. 
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Post-Activity Discussion 
Presentation of conclusions 

 

This is illustration for presentation of VMOSA , Good practice (DAE Strategy training in Lodz, 
January, 2019)  
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Session 4: Action plan for implementation of ICT  
Introduction 
Notes on the choice: A 5-day workshop / work in groups with trainers – day 4 

An objective is to develop specific time-sensitive plan used to measure your progress towards 
achieving your goals and vision. 

Methodology 
Session is face-to-face with an approximate duration of 3,5 hours. Methods: group work, 
brainstorming, discussion. 
 

Learning objectives 
 To plan a strategy of introducing ICT 

 Developing the tools of implementation ICT strategy 

 Developing an action plan for introducing ICT in the institution  

Learning outcomes  
LO1: Managers will be able to define needs in regards to implementation of digitalization 
strategy. 

LO2: Managers will be more conscious strategy  

LO3: Managers will be able to design activities to implement in the institution 
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Activity 1 
Work as a group: all co-workers elaborate the action plan for your institution/organization. 

After you give a set of instructions, give participants buddies time to go over the instructions to 
make sure that everyone understands what they are to do. 

Action plan (what change will happen; who will do what by when to make it happen) 

 Action step(s): What will happen 

 Person(s) responsible: Who will do what 

 Date to be completed: Timing of each action step 

 Resources required: Resources and support (both what is needed and what's available)  

 Barriers or resistance, and a plan to overcome them! 

 Collaborators: Who else should know about this action 

An Ambassador responsible for implementation of digitalization strategy should be appointed 
in each educational centre. 
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Post-Activity Discussion 
Space for discussing case studies and best/ good practices  

 

 

This is illustration showing how an action plan looks like: ideas and crucial decisions are written 

down, easy to elaborate in details. Good practice (DAE Strategy training in Lodz, January, 2019)  
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Session 5: Cooperation and follow up activities 
Introduction 
Notes on the choice: A 5-day workshop / work in groups with trainers – day 5 

In this session, we are going to summarize the entire workout and create final strategy 
A package of actions and procedures recommended for the institution should be developed as 
a product of the common strategy developed for the necessary changes and implementation of 
new technologies. Such a package should be outlined and endorsed by the whole community of 
the institution. Information about activities for all stakeholders should be planned on each stage 
of the implementation of the new technologies. 

Methodology 
Session is face-to-face with an approximate duration of 3,5 hours. Training sessions for 
managers: recognizing organizational potential of the institution. Recognizing participants’ 
beliefs, intentions and resources - Learners come with beliefs about the role of technology in 
learning which impacts upon the way they use technology. 
Methods: group work, discussion. 
 

Learning objectives 
 To plan a strategy of introducing ICT (Action Plan) 
 To structure future cooperation and follow up activities  
 To understand the final strategy 

Learning outcomes 
LO1: Managers will be able to plan and execute the actions necessary to implement digitalization 
strategy 

LO2: Managers will be able to set goals of each activity  

LO3: Managers will be able to create final strategy 
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Activity 1 
Each participant presents the strategy developed during the 5-days workshop. 

Is really important to create the space for presentation all the work (SWOT, VMOSA, Action 
plan) in the workshops room. 
 

 

 
This is illustration for presentation and summary of SWOT and VMOSA conclusions. Good 

practice (DAE Strategy training in Lodz, January, 2019)  
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Post-Activity Discussion 
 
Space for discussing future cooperation and planning follow up activities. 
 
Have participants write down their thoughts about one or two things they have learned that had 
an impact on them.  In other words, is there something that was learned in workshop that 
changed the way they view things?  Or was there something that surprised them? Or was there 
something that altered the way they think about things? Etc. 
 
In small groups or with a partner participants should respond to the following… 

 A pleasant surprise… 
 Something that you had to struggle with to understand  
 Something you don’t agree with  
 Something that you agree with strongly  
 Something you thought was particularly interesting  
 Something you didn’t expect  
 Something you want to know more about  
 A question that you have 

 

 
This is illustration for presentation and summary of training outcomes and conclusions. Good 

practice (DAE Strategy training in Lodz, January, 2019)  

 
 
Here are some other questions that have generated related to forum discussion 

 What is the power of the strategy? 
 Why my participation is so important? 
 What I would do better? 

 
 

 

                                                                           Enjoy your training!! 
  



Strategies to Digitalize Adult Education 
2017-1-ES01-KA204-037991 

  
 

The European Commission support for the production of this publication does not constitute an 
endorsement of the contents which reflects the views only of the authors, and the Commission 
cannot be held responsi-ble for any use which may be made of the information contained 
therein 

Annex I: SWOT template 
 

Strengths 

 

 

 

 

 

 

 

Weaknesses 

 

 

 

Opportunities 

 

 

 

Threats 
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Annex II: SWOT theory 
 

SWOT analysis is a strategic planning technique used to help a person or organization identify 

strengths, weaknesses, opportunities, and threats related to business competition or project 

planning. Is an incredibly simple tool to help organization develop business strategy? 

The name is an acronym for the four parameters the technique examines: 

 

SWOT – Strengths, Weaknesses, Opportunities, Threats 

 Strengths: characteristics of the business or project that give it an advantage 

over others. 

 Weaknesses: characteristics of the business that place the business or project 

at a disadvantage relative to others. 

 Opportunities: elements in the environment that the business or project could 

exploit to its advantage. 

 Threats: elements in the environment that could cause trouble for the business 

or project. 

 

 

Created in the mid-20th century by Albert Humphrey, a business consultant, SWOT analysis is 

one of the most used self-improvement methods in the business world nowadays. SWOT 

analysis aims to identify the key internal and external factors seen as important to achieving an 

objective. SWOT analysis groups key pieces of information into two main categories: 

Internal factors — the strengths and weaknesses internal to the organization 

External factors — the opportunities and threats presented by the environment external to the 

organization 

The degree to which the internal environment of the firm matches with the external 

environment is expressed by the concept of strategic fit. Identification of SWOTs is important 

because they can inform later steps in planning to achieve the objective. First, decision-makers 

should consider whether the objective is attainable, given the SWOTs. If the objective is not 

attainable, they must select a different objective and repeat the process. 

SWOT analysis examples to download, print or modify online from www.creately.com 

There are many more SWOT analysis templates ready to use. 
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SWOT analysis can be used effectively to build organizational strategy. Typically, it is used in a 

strategic planning process to effectively evaluate where the company stands before moving 

forward with an opportunity or managing a limitation. 

How TO DO a SWOT Analysis? 
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To help you to carry out your analysis: 

1. Decide who should be involved 

2. Designate a Facilitator 

3. Download/print off/draw template - (using the popular 2x2 matrix) 

4. Brainstorm - one of the best ways to do this is to have a flipchart and write down 

everyone’s responses there. 

5. Write down answers to the following questions 

6. Remove Duplicate - after this process, the main ideas and points should be the only 

ones still on the flipchart. 

7. Clarify and Identify 

8. Assign Next Steps 

 

 
Ideas frequent SWOT analysis questions regarding/ questions are asked to identify/ questions 

that one must ask to find: 

 Strength 

 Weaknesses, 

 Opportunities, 

 Threats. 

 

Strengths 

 What advantages does your organization have? 

 What do you do better than anyone else? 

 What is the unique thing about your company? 

 What unique or lowest-cost resources can you draw upon that others can't? 

 What do people in your market see as your strengths? 

 What are your assets? 

 Which one of those assets is the strongest? 

 Do you have a strong customer base? 

 How skilled are your co-workers? 

 What are the things that other people say you do well? 

 Do you have experience in this task (mission)? 

 What are the advantages you have over your rivals? 
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Weaknesses 

 What could you improve? 

 What are people in your market likely to see as weaknesses? 

 What are the things you need to avoid? 

 What areas do your competitors have an advantage on? 

 Are you lacking in knowledge? 

 Are your employees not skilled enough? 

 Do you have enough investment to start such a project? 

 Is your customer base too low? 

 Are you making enough profit? 

 Is your competitor running miles ahead of you? 

 

Opportunities 

 What good opportunities can you spot? 

 What interesting trends are you aware of? 

 What external changes will bring your opportunities? 

 What are the current ongoing trends? 

 Will these trends affect you in a positive manner? 

 Can you take advantage of the local market? 

 What is the market missing? 

 Can you provide that missing link for the consumers? 

 Is your rival company failing to satisfy their customer base? 

 Is your brand name helping you to get finance easier? 

 

 

Threats 

 What obstacles do you face? 

 What are the obstacles you are facing in the current mission? 

 What are your competitors doing? 

 Are quality standards or specifications for your job, products or services changing? 

 Is changing technology threatening your position? 

 Could any of your weaknesses seriously threaten your business? 

 What are the negative aspects in the current market? 

 Are there potential competitors who can give you a competition in the future? 
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 Are your key staff members satisfied with their wages and other benefits? 

 Do you see them being poached by your rivals? 

 Are the government regulations going to affect you? 

 Will political instability hurt you? 

 

 

For a SWOT analysis to be effective participants need to be deeply involved. This isn’t a task 

that can be delegated to others. Select people who can represent different aspects of 

organization. 

 
Sources 
Wikipedia (2019) SWOT analysis. Available from https://en.wikipedia.org/wiki/SWOT_analysis 

Mind Tools, SWOT Analysis (2019) Available from:  www.mindtools.com/rs/SWOT 

PESTLEAnalysis.com. (2019). Using SWOT in Business Analysis. [Online]. Available from: 

http://pestleanalysis.com/swot-business-analysis/ 
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Annex III: VMOSA theory 
 

The VMOSA process grounds your dreams. It makes good ideas possible by laying out what 

needs to happen in order to achieve your vision. 

By creating this process in a group effort (taking care to involve both people affected by the 

problem and those with the abilities to change it), it allows your organization to build consensus 

around your focus and the necessary steps your organization should take. 

The process gives you an opportunity to develop your vision and mission together with those in 

the community who will be affected by what you do. That means that your work is much more 

likely to address the community’s real needs and desires, rather than what you think they might 

be. It also means community ownership of the vision and mission, putting everyone on the same 

page and greatly increasing the chances that any effort will be successful. 

VMOSA allows your organization to focus on your short-term goals while keeping sight of your 

long-term vision and mission. 

 
SMART goals - defining goals to be specific, measurable, attractive, realistic, time-based 
 
 

Ideally speaking, each corporate, department, and section objective should be:  

 Specific – target a specific area for improvement. 
 Measurable – quantify or at least suggest an indicator of progress. 
 Assignable – specify who will do it. 
 Realistic – state what results can realistically be achieved, given available resources. 
 Time-related – specify when the result(s) can be achieved. 
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Vision 

A vision statement is a mental picture of what you want to achieve. Don’t make it cluttered or 
complicated. A vision statement should be simple enough so you can hold the meaning of it in 
your “mind’s eye”.  

Mission  

A mission statement defines how you will achieve your vision. It is an action statement and often 
begins with the word “to”.  

Once again it needs to be simple so that you can easily hold the idea in your mind. 

Core Values 

Core values are standards you place on your business activities. Examples include ethics, 
environmental issues, labor standards, etc.  

In addition to the mission statement you may want to state your goals and objectives for the 
project.  

Goals 

A goal is a general statement of what you need to achieve to accomplish the vision of your 
business project.  

Objectives 

An objective is a specific time-sensitive milestone used to measure your progress towards 
achieving your goals and vision.  

 

Action plan (what change will happen; who will do what by when to make it happen) 

 Action step(s): What will happen 

 Person(s) responsible: Who will do what 

 Date to be completed: Timing of each action step 

 Resources required: Resources and support (both what is needed and what's available) 

 Barriers or resistance, and a plan to overcome them! 

 Collaborators: Who else should know about this action 
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ICT Training 
Strategies to Digitalise Adult Education 
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ICT Training 
The ICT Training module allows the leader of the digitalisation activity to train the trainers and 
teachers of the centre in several technologies that should help them deliver their lessons in a 
more effective way. 

The sessions of this module cover aspects like document maintenance, improving the accuracy 
when searching for information, creating new multimedia lessons, e-learning and copyright 
and open licenses. 

The sessions can be used independently as needed, and can be easily adapted to the needs of 
the centre. 
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Session 1: Creating and maintaining documentation 
Introduction 
The first session covers the usage of an office suite, including both word processor, spreadsheets 
and slides, as well as collaborative working. For that, we will be using Google Drive, which is a 
popular, free and scalable complete office suite available online. 

Methodology 
Session is face-to-face with an approximate duration of 3,5 hours. Approach should be as 
practical as possible, rounding the 80/20 percent of the time in practice and theory, respectively. 

Learners need a computer with Internet access, and should work individually, as this session 
emphasises on working collaboratively through an online platform. 

Learning objectives 
 To understand the necessity of proper content maintenance 

 To have a competent knowledge of the use of an office suite 

 To be able to create and share documentation 

Learning outcomes 
LO1: learners will be able to create efficiently documents, slides and spreadsheets  

LO2: learners will be able to reuse and update documentation created with an office suite 

LO3: learners will be able to review, track changes and comment documents for sharing with 
other people 
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Lesson 1: Navigating through Google Drive 
First of all, we will need a Google account. It may be an already existing email that we sign up 
with in Google, or an account we create for Gmail in https://mail.google.com. 

Our working space will be located in https://drive.google.com. From here we will access all of 
our documents, as well as manage all of the shared files. 

 

Figure 1: Google Drive main screen 

From here we can right click a document a choose Share to change the sharing options of the 
file. This is where we’ll invite people to work with. 
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Figure 2: Sharing a file 

 

Activity 1: Have your class sign up with an account. Create a folder and share it with your 
learners. 
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Lesson 2: Maintaining documents with Google Docs 
Table of contents 
The table of contents allows us to automatically create a list of headings and sections under the 
document. This is helpful (and almost mandatory) in documents with several modules and 
multiple pages. In addition, when exported to format like PDF or website, the references of the 
table become clickable links to their sections. 

Activity 1: First, we identify one or more participants that do not know how to create a table of 
content, and ask them to describe the process they are using to generate an index in their 
documents. Understanding what is wrong and what can be improved is essential for this training. 

To insert a table, we need to go to Insert -> Table of contents. 

 

Figure 3: Inserting a table of contents in Google Docs 

An empty table of contents will appear. To fill it with links, each section of our document has to 
be titled with a heading. Headings are special paragraphs that identify the different sections of 
our document, and are used by the TOC to create the reference list. To select a heading level, 
put the cursor on the title text and choose a heading in the Styles option: 
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Figure 4: Choosing the header level 

 

Then we will need to update our table of contents. Click on the reload button: 

 

Figure 5: Updating the table of contents 

The resulting table of contents will have the headers as indexes, and will show the number of 
the page the content is (depending on the type of table of contents we chose). 

 

Figure 6: Resulting table of contents 
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Styles 
It is obvious that we can format our document the way we want, and completely change the 
appearance of it from the default style. 

We have two ways to do it: the manual way, individually changing the colours, sizes, margins 
and rest of properties of every chunk of text, or we can define the default style of our document 
and let Google Docs format the content for us. 

The advantage is obvious: not only we save a lot of time by not having to edit every paragraph 
manually, but also it allows us to create templates and reuse the same style for multiple 
documents. For example, if we want to author the content of a full course and every document 
has to have the same style, this is the way to go. 

Google Docs has style definitions for the paragraphs, the titles and the headings. 

We find the section to apply and modify the styles under Format -> Paragraph styles. We can 
apply a define style here, or we can change its default appearing with “Update to match”. This 
way we’ll modify how every one of those sections look like in the document. 

 

Figure 7: Updating a paragraph style 

Activity 2: Ask the participants to change the highlight colour of the headings by using styles. 
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Working collaboratively 
What if several people want to work on the same file at the same time? Just sharing the file will 
allow every user to access the file and modify it. The changes made by them will be seen by 
everybody in real time. 

In addition to this feature, we can add comments to the document – that is, without really 
modifying the document. For that, we select the piece of text we want to comment and we click 
on the floating button on the right. 

 

Figure 8: Adding a comment 

The result will be visible to the right side of the document. Other users can then reply to this 
comment, or resolve and close it. 

 

Figure 9: Adding a comment 

Additionally, we can suggest edits to the document. 

 

Figure 10: Changing to suggestion mode 

This way, any modification we make will be seen as a suggestion, and not a change. Someone 
will have to manually accept it to be inserted in the document. 
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Figure 11: Suggesting a modification 

Activity 3: Create the structure for a weekly plan. Choose one learner as the main editor. Give 
the rest of the learners access only to suggest edits. Now, let the whole class fill the whole plan 
by using comments and suggestions. 
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Lesson 3: Working with a spreadsheet 
Filtering and sorting data 
Even though it is easy to use the formulas in a Google Spreadsheet, to compute almost any kind 
of operation with the data, there are still some features to make our life even easier. For 
example, let us imagine this shopping list: 

 

Figure 12: Example of data in a spreadsheet 

Activity 4: Let the learners inspect the interface and find their way. Ask them to sort the data by 
price (Hint: put the cursor on column C, and go to Data -> Sort sheet by Column C). 

But what if we need to sort the data multiple times? How can we order it by price? How can we 
reverse the date order? How can we show only some data? Easily: by creating a filter. 

 

Figure 13: Creating a filter 

To create a filter we should select our data and click on the Create a filter button. It 
automatically detects if it has headers. 
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Figure 14: Resulting filter. Note the icons to the right of the headers. 

Now it’s easy for us to sort or filter the data of our table. In the Figure 15 we can see how we 
can sort in an ascending or descending way (1), we can filter by a condition (i.e. the value is 
greater than other, or the date is previous to another) (2) or we can filter by the values (3). 

 

Figure 15: Filtering 
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Converting text into data 
Sometimes we have data in a spreadsheet that we cannot work with, because it’s not numeric 
or it has more than one piece of information in one cell. For example: 

 

Figure 16: Example of overcrowded cells 

In Figure 16 we have a column (Name) where the names are separated by a comma, and another 
column (Age range) indicating the estimated minimum and maximum of their ages. We cannot 
work with this data: we cannot sort by first name and we cannot make calculations by minimum 
or maximum values. 

Activity 5: Ask your learners how they would solve this problem. See how many alternative 
solutions are. 

We have the possibility to split text into columns. It’s important to leave as many blank columns 
to the right as new columns we will need. Then we go to Data -> Split text to columns and select 
the separator. In the column A, the separator will be a comma, where as in column C we’ll 
separate by a dash. 

 

Figure 17: Splitting into columns 

Now we can change the headers of the new columns and work with the new data. 

Activity 6: Make a similar file with different columns to separate and allow your learners some 
minutes to practice. 
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Lesson 4: Working with slides 
Editing the masters 
Activity 6: Make them understand the problem: ask a volunteer to create a presentation, with a 
certain design where a logo is present in all of the slides. After creating several slides, ask the 
learner to change that logo from all of the slides, and ask them if they know how that could have 
been prevented. 

Similar to Docs, Google Slides allows creating templates for the slides, so that every time you 
create a new slide it appears with a style we have defined. In addition, the objects (images, texts, 
etc.) that we insert into the slide will be blocked, so they will not be moved or removed 
accidentally while creating our content. 

Let us put us into situation: imagine we have to create a presentation. By default, it will have a 
cover slide, several content slides and a closing slide. For the content slides, we will have two 
different types: one with the images on the left, and one with the images on the right. So, how 
can we automate these slides without having to use the rudimentary procedure of duplicating 
slides and removing the content of the previous one? By using the Slide Master. 

The Slide Master allows the author to modify the layouts, the slides that will serve as templates 
for the real slides we will use in our presentation, with their own style and content blocks. Once 
edited (or created) a layout, we can apply it to the slides we are using or create new ones using 
it. 

To access the Slide Master for our current slide, we need to go to Slide -> Edit master. 

 

Figure 18: Entering the editor of masters 
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Figure 19: Slide master editor 

On the black sidebar, we see the master slides and the layouts. On the top of the right widget, 
you can see the name and how many slides are using this layout. On the Insert menu, you will 
be able to add images and other objects as you would normally would. However, one of the 
extra things you can do here is to add a placeholder. A placeholder is a box with dotted borders 
that will allow the author to add specific content in the layout. For example, imagine we are 
creating a presentation template for a conference where multiple speakers will participate, and 
each of them will use the same template. We can add a placeholder in the cover slide for the 
speaker to add their name and organisation in a position we decide (like on a side, or in a corner). 

After modifying a layout, it is possible that we need to reapply the layout to some of the slides. 
For this, right click on the slide -> Apply layout -> choose the layout. 
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Session 2: Creating educational content 
Introduction 
Having a textbook with the lessons and the exercises is good, but it doesn’t derive much from 
the traditional way of delivering teaching content. 

Nowadays most of the students have computers, tablets or smartphones where they already 
look for resources and external information to complete their knowledge and improve their 
homework, and they’re not only looking in the Wikipedia. Video lessons on media platforms like 
YouTube are quite popular as they provide a direct visual explanation to the learner. 

If you had to choose between reading a lesson for an hour and watching a video lesson for 15 
minutes, what would you choose? 

In this session, we are going to focus on learning how to easily create multimedia lessons, and 
publish them and get the maximum out of our e-learning platform. 

Methodology 
Session is face-to-face with an approximate duration of 3,5 hours. Approach should be as 
practical as possible, rounding the 80/20 percent of the time in practice and theory, respectively. 

Learners need a computer with Internet access, and they will work in small groups (2-3 people) 
for some of the activities. 

Learning objectives 
 To broaden the knowledge on available tools and options 

 To be able to create educational content using a variety of visual tools 

 To encourage the teacher to discover new tools to better present their content 

Learning outcomes 
LO1: learners will be able to generate immersive multimedia lessons  

LO2: learners will be able to find and adapt to new authoring tools 

LO3: learners will be able to understand the needs of their students to better implement their 
lessons 
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Lesson 1: Creating interactive lessons with Edpuzzle 
Edpuzzle is an online tool that allows you to grab a video from several sources (like YouTube, 
National Geographic or Khan Academy) and convert it into an interactive lesson. 

Imagine that you have a video about physics in YouTube, and a chunk of 4 minutes of it is just 
what you need to explain the lesson to your students. With Edpuzzle you can crop those 4 
minutes out of the video, create audio notes (or even replace the full audio track) and insert 
evaluable quizzes in specific points. 

Edpuzzle allows a teacher to create up to 10 lessons for free, and encourages schools to contact 
them in order to agree on the price of the premium version. 

Activity 1: First things first: https://edpuzzle.com. Let your learners get inside and create an 
account. 

 

Figure 20: To the left, the sources for the videos. On top, the different sections to search videos, manage your lessons 
and manage your classes 

To create a lesson, go to the Search tab and select a source in the left sidebar, like YouTube. Put 
your keywords in the search bar and choose a video by hovering the mouse over it and clicking 
on Use it. 
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Figure 21: Editing our lesson 

There are four tools we can use while editing our lesson, to be selected from the bar over the 
video. First one allows us to crop the video, in case we don’t want to use the full video. The 
second tool allow us to remove the original audio track and replace it with our own recording. 
Third tool will insert an audio note that we will record in a specific point of the video (by default 
where the cursor is, but we can move it afterwards). And the last but not least lets us create a 
quiz in a specific time, with an open question, a multiple choice or just inserting a comment. 
Later we’ll be able to check and grade the answers of our students. 

We can periodically save the lesson by clicking on Save on the top, and hit Finish once the lesson 
is ready. 
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Figure 22: Finishing our lesson 

If it’s our first time creating a lesson, Edpuzzle will ask us to create a course. A course will allow 
us to organise our lessons better, as well as to add our students. Once our students are inside 
our class in Edpuzzle they’ll be able to access all of the lessons. 

If in the same window we click on Share with anyone we’ll get the following options: 
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Figure 23: Sharing our lesson 

This way we can distribute the link, use the embed code to insert it into another channel, like 
our e-learning platform or a website, or share it through social networks and email. 

Activity 2: Divide your class in small groups (2-3 people max) and assign a topic to each one. Give 
them 10 or 15 minutes to develop a short lesson and allow them to show it to the class. 
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Lesson 2: Recording our own lessons with Screencast-O-Matic 
Sometimes, to prepare a lesson, we need to show what we’re working on at the same time. It’s 
typical in ICT related courses where the teacher has to show the students step by step how to 
do something, but not exclusive. A geography teacher could use Google Maps to talk to the 
students about the borders, or a math teacher could use Mathematica to solve integrals. Or they 
can just write the steps and record themselves doing it. 

Screencast-O-Matic allows you to record your screen and your microphone so that you can make 
video lessons showing exactly what you need to do. The free version allows you to record up to 
15 minutes, but the premium version removes this limitation and allows you to also record the 
system sound (i.e. the sound that the applications are emitting). You can download Screencast-
O-Matic from https://screencast-o-matic.com/ 

 

Figure 24: Screencast-O-Matic Screen 

Screencast-O-Matic is very simple to use. Top bar will make us choose what to record: our 
screen, our webcam or both. If we choose both, our screen recording will have our webcam 
occupying part of the screen. 

Then we can modify the maximum time we can record (only in the paid version), the size (we 
can choose to only record the active window, or the full screen, or just part of it) and choose 
whether it should record our microphone (narration) and our computer audio (only in the paid 
version). When we have chosen our options, we shall click on the Rec button. 

 

Figure 25: The interface while we are recording 
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Figure 26: The interface while the recording is paused 

We can pause the recording once it has started, and from the paused screen we can preview 
what we’ve done, resume it, discard it or finish it. Once we hit Done we can save the video to 
our computer or publish it. 

 

Figure 27: Finishing our recording 

The free version will allow you to upload it directly to your YouTube channel, while the paid 
version will also add Google Drive to the publishing services. For that, you will need to allow 
Screencast-O-Matic access to your account by following the instructions it will give you. 

  



Strategies to Digitalize Adult Education 
2017-1-ES01-KA204-037991 

  
 

The European Commission support for the production of this publication does not constitute an 
endorsement of the contents which reflects the views only of the authors, and the Commission 
cannot be held responsi-ble for any use which may be made of the information contained 
therein 

Lesson 3: Publishing our content in YouTube 
YouTube is, as of today, the multimedia social platform with the biggest user base, the biggest 
impact and the biggest library. Because of this, having a YouTube channel can make your video 
lessons more accessible to your students, as well as helping them find related content. 

To access YouTube as content creators we just need a Google account. To upload a video, click 
on the upload button at the right side of the top bar. 

Activity 4: Let’s start by uploading the video we’ve created with Screencast-O-Matic. 

 

Figure 28: Uploading a video in YouTube 

Uploading a video is as easy as it gets. Just drag and drop the video file into the browser window 
o click on the image and select it. It’s also important to set the privacy right. A public video will 
be available for everybody, and will appear in the search if someone looks for the correct 
keywords. An unlisted video won’t appear in any search, but will be accessible by those who 
have the link. A private video will only be visible for the specific users we’ve manually allowed. 
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Figure 29: Uploading a video to YouTube and adding information 

In the next screen we’ll see the progress of the upload. We’ll also be able to edit the information 
of our video. This is important: a video with the correct description and tags will be more visible 
when someone is searching for something related. We finish the upload by clicking on the blue 
Publish button. 

Now that we have our first video, there are two more things we can do: manage our channel or 
further edit the video in the Creator Studio. 

 

Figure 30: My Channel and Creator Studio locations 

The Creator Studio allows you to modify the info of the video we previously entered, but also 
lets you enhance the image and the audio, replace the audio track for stock music, add 
annotations and cards and one of the most important features: add or create subtitles to the 
video. 
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Figure 31: Creating new subtitles for our video 
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Lesson 4: Creating interactive lessons with Udutu 
Udutu is an online web-based application that allows us to create interactive presentations – 
slides that can contain quizzes, galleries, questions or even decisions, making it ideal for 
branching games. 

 

Figure 32: Udutu 

In the Figure 32 we can see the different kind of items we can add: 

 A folder, where we can group slides of the same purpose (imagine a branching game 
where we can group different paths in folders). 

 A basic screen containing content and a possible jump. A jump is a question where the 
choice will take you to a different slide (for branching games, this is what we want). 

 An interactive screen, like image rollovers, galleries, etc. with a possible jump. 
 A menu screen with buttons. 
 A scenario, a set of slides already built to follow a pre-defined structure. 

 

Figure 33: Inserting a scenario 
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Activity 5: Create a branching game with your learners. First, allow your learners to think about 
a starting point: i.e. “someone enters a bar”. Then think about each possible choice and scenario. 
After it, bring volunteers to make each of the stages. 
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Session 3: E-learning 
Introduction 
Even though e-learning is not a new concept, there is still a mystery cloud surrounding the term. 
Used by teachers and trainers all around the world and being implemented in most Higher 
Education Institutions, an e-learning platform offers educators and learners alike a common 
working ground. 

Note: in annex I you can find a Moodle’s usage tutorial, in case you need to better familiarize 
with a learning platform. 

Methodology 
Session is face-to-face with an approximate duration of 3,5 hours. Approach should be as 
practical as possible, rounding the 80/20 percent of the time in practice and theory, respectively. 

Learners need a computer with Internet access, and they will work in small groups (2-3 people) 
for some of the activities. 

Learning objectives 
 To understand the necessities and rationale behind online and blended learning 
 To analyse and implement the needs of the teachers and learners into a virtual 

environment 
 To adapt and create lessons for an e-learning capacity 

Learning outcomes 
LO1: learners will be able to assess the best way to deliver a lesson through an e-learning 
platform 

LO2: learners will be able to access, create, edit and deliver lessons online 

LO3: learners will be able to evaluate, monitor, mentor and grade students online 
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Lesson 1: Understanding the different types of learning 
We can divide the teaching/training methods depending on the availability of the teacher and 
the learners. Traditional learning would refer to the classical approach of the learners attending 
physically (or even virtually through a camera) the classroom. E-learning or distance learning 
implies the opposite: learners don’t have to attend the class at all, and instead they’ll take the 
class through a virtual learning environment (VLE), usually with the freedom of choosing when 
and where. 

There’s still a third choice, which we’ll focus on this guide: blended learning. Blended learning 
mixes both of the previous approaches into one: part of the learning will require the learner to 
attend to class, and the other part the learner will have to complete through a VLE. The usual 
case for schools in blended learning is when the learners have to access the VLE after the class 
to make the homework online, or to submit an essay, or to participate in discussions. 

For easiness and because we’ll only focus on the online part, we’ll focus on the e-learning part 
of our teaching approach.  

Lesson 2: How does it change from traditional approach? 
There’s a common fear from the teachers and trainers to move from traditional learning to any 
form that implicates online learning. 

First thing we have to understand is that the transition is not dramatic at all, and doesn’t really 
imply a change of paradigm. Whoever is a good teacher when the learners are in front will also 
be a good teacher when they’re learning across a screen. Whoever is a terrible teacher will still 
have problems transferring knowledge to its learners. E-learning is not going to change that. 

E-learning will, however, give you a huge set of tools to publish, author and distribute your 
content, homework, exercises and media to your learners in the most convenient ways. 

Activity 1: Ask the classroom: Do they usually engage their students with any learning 
environment? How? 

The advantages of e-learning under a blended learning approach comes in its versatility. 
Traditionally you would create a lesson and teach it in your classroom. Sometimes you’d even 
share it with your learners to take it at home. In e-learning you do the same. But in e-learning 
you can complement this lesson with other resources: you can create a self-assessment quiz for 
the learner to evaluate their own knowledge, you can design the lesson as a branching 
game/serious game with ramifications and multiple paths, you can deliver the lesson as a video 
or a podcast or even as a videogame, you can deliver the lesson as a focus group through a 
communication tool (i.e. a forum). You have a plethora of tools to use and it’s up to you to deliver 
the course in the most dynamic way you think will be beneficial for your learners. 

It’s an error to have an e-learning platform available and use it only to store files and links as if 
it were just a Dropbox folder. Maximize the use of activities, gamify your course through badges, 
user levels and points and engage your learners with collaborative tools. But do not fill your 
course with PDF and PowerPoint files and links to other websites. E-learning platforms have 
their own internal tools to create lessons, use them. 
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Lesson 3: What choices do I have? 
There are several choices for e-learning platforms available, some of them are free and some of 
them are not (though some of them will give your organisation a discount if you’re a public or 
non-profit education institution). 

Activity 2: Ask around: Do they use any e-learning platform? Which one? What’s their opinion 
about it? 

One of the most popular pieces of software is Moodle, used by schools, VET, HEIs and overall 
any kind of organisation. Moodle is free, open source and actively developed, supported and 
extended by third-parties. Google has its own popular solution called Google Classroom which 
integrates easily with the rest of the Google Suite tools. Edmodo and Canvas are other very 
popular solutions too. 

Activity 3: Choose one e-learning platform, create a course for your learners and make them 
enrol themselves into it. 

Activity 4: Let’s them learn by experimenting. Divide the class in groups of maximum 3 people, 
choose a general topic for a subject (i.e. Biology) and assign each group a subtopic (i.e. Blood 
flow, Nervous System, etc.). Have each group create, inside the same course and under their 
subtopic, a lesson about it, with quizzes, surveys, a glossary and external resources. Let them 
familiarize with the interface for a few minutes before you help them find the way. 
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Session 4: Finding OER, improving our searches 
Introduction 
With an almost infinite amount of resources available on Internet, we don’t need to create 
everything from scratch. Multiple sources for educational repositories exist and allow us to use 
and even modify and adapt their resources. 

Also, not everything is in the first page of our Google searches. Sometimes we are not searching 
correctly or we could make a more accurate search by filtering in or out what we want. In this 
lesson we will see how to use Google in our advantage. 

 

Methodology 
Session is face-to-face with an approximate duration of 3,5 hours. Approach should be as 
practical as possible, rounding the 80/20 percent of the time in practice and theory, respectively. 

Learners need a computer with Internet access, and they will work in small groups (2-3 people) 
for some of the activities. 

Learning objectives 
 To understand what are OER and their benefits in education 
 To learn how to search and reuse OER content 
 To work more efficiently by using advanced searches 

Learning outcomes 
LO1: learners will be able to find information in a more efficient way 

LO2: learners will be able to use specialised content databases to find and share educational 
material 

LO3: learners will be able to reutilise and import their educational content in e-learning 
platforms  
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Lesson 1: Class Resources 
Alison 
As we never stop learning, Alison is an e-learning provider with thousands of free (and not free) 
courses in many categories, from IT to health care, that you can take and use either for yourself 
or for your students. Some of the courses of Alison will even provide you with a certification. 

Website: https://alison.com 

ClassFlow for interactive whiteboards 
ClassFlow is a free service made for interactive whiteboards. It consists in a web-based 
application that allows you to create interactive presentations, assign them to a class, and then 
have your learners join it and deliver the lesson in your interactive whiteboard. Your students 
will follow from their computers and from the IWB, and you can do quizzes and activities that 
each student have to answer on their own. 

Another strong point of ClassFlow is the resources repository it has. You can find hundreds of 
lessons already finished for you to reuse, modify and deliver. 

Website: https://classflow.com/ 

Activity 1: Group the learners by 2 or 3 and have them create a lesson. Then, play some of them 
for everybody. 
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Lesson 2: Fine-tuning our Google searches 
Google allows many parameters to fine-tune our searches in every product: Google Search, 
Google Mail, Google Drive, Google Images… 

We will refer to search term or simply term to every keyword that we introduce in a search. It 
can be a single word or a sentence. 

Some of these parameters are: 

Parameter What does it do? Example 
“search term” When we put a sentence between 

quotation marks, we convert the 
whole sentence in a search term. This 
way, Google will show only the 
results that contain the exact 
sentence in the proper order. 

“Hello, how are you?” 
Shows results containing the exact 
sentence. 

- (minus) In front of a term, Google will remove 
every result that contains it. 

cars -mercedes -bmw 
Shows the results containing the 
term “cars” but not the terms 
“Mercedes” and “bmw”. 

site: Google will show all of the results that 
exist inside of that website 

site:http://reddit.com 
Shows only results coming from 
reddit.com 

intitle: Shows the results containing the term 
in the title of the website. 

intitle:wireless home 
Shows the results containing the 
term “wireless” in the title, but may 
contain “home” in other parts (the 
URL or the page content). 

allintitle: Shows the results containing all of the 
terms in the title of the website. 

allintitle:wireless home 
Shows the results containing the 
terms “wireless” and “home” in the 
title of the page. 

inurl: Shows the results containing the term 
in the URL of the website. 
As with intitle, allinurl exists. 

inurl:camera online 
Shows the results containing the 
term “camera” in the URL, but may 
contain “online” in other parts. 

intext: Shows the results containing the term 
in the page content. 
As with intitle, allintext exists. 

intext:secure wifi 
Shows the results containing the 
term “secure” in the page content, 
but may contain “wifi” in other parts 
(URL or title). 

filetype: Filters the results by the type of the 
file. Very useful to find PDF or Word 
documents. 

moodle guide filetype:pdf 
Looks for PDF files containing the 
terms “moodle” and “guide”. 

define: Returns the definition of a word or 
expression. 

define:operator 
Returns the meaning of “operator”. 

link: Shows the results that contains a 
given link. Useful to check who’s 

link:https://blog.inerciadigital.com 
Shows the results that links to 
blog.inerciadigital.com 
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talking about us or linking to our 
websites. 

related: Returns websites with similar content 
that the one you’re pointing at. 

related:https://elpais.com 
Shows similar websites 
(newspapers). 
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Session 5: Copyright and Intellectual Property 
Introduction 
Most of the teachers are also, sometimes without realising, authors. We have to create our 
lessons, contents and workbooks for our students. Then we have to distribute them, to our 
students, to the other teachers, or even to the public domain if we decide so. 

But we have to be careful, especially if we decided to reutilise resources from other authors. 
Can we do it? How does the copyright exactly work? To what extent can we use theses contents? 

In this session, we are going to explore the concepts of copyright and licensing to make sure that 
our content is well protected. 

Methodology 
Session is face-to-face with an approximate duration of 3,5 hours. Approach should be as 
practical as possible, rounding the 80/20 percent of the time in practice and theory, respectively. 

This session is the most theoretical of all, and probably the most boring. A good way to present 
it is to make a quiz (for example with Kahoot! or Quizizz) and progress through the content while 
the learners assess their own knowledge about the topic. 

Learning objectives 
 To know about the common legal framework for intellectual property 
 To understand the use of open licenses 
 To understand the possibilities of reutilisation of other’s materials 

Learning outcomes 
LO1: learner will know when they can reuse other’s materials and in which conditions 

LO2: learner will be able to protect their intellectual property  
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Lesson 1: Copyright: What it is and what does it imply? 
The Wikipedia1 has an excellent definition for it that covers most of the points that we are 
going to treat: 

Copyright is a legal right created by the law of a country that grants the creator of an original 
work exclusive rights for its use and distribution. This is usually only for a limited time. The 
exclusive rights are not absolute but limited by limitations and exceptions to copyright law, 
including fair use. A major limitation on copyright is that copyright protects only the original 
expression of ideas, and not the underlying ideas themselves. 

The moment the author stamps the name into the creation, he/she automatically reserves all 
of the rights for use, modification and distribution. That easy. Even though each country has 
specific laws and rules for copyrights, most of the countries work under the same copyright 
frameworks such as the Berne Convention which recognises the author with the exclusive 
rights of authorisation for2: 

 the right to translate, 

 the right to make adaptations and arrangements of the work, 

 the right to perform in public dramatic, dramatico-musical and musical works, 

 the right to recite literary works in public, 

 the right to communicate to the public the performance of such works, 

 the right to broadcast (with the possibility that a Contracting State may provide for a 
mere right to equitable remuneration instead of a right of authorization), 

 the right to make reproductions in any manner or form (with the possibility that a 
Contracting State may permit, in certain special cases, reproduction without 
authorization, provided that the reproduction does not conflict with the normal 
exploitation of the work and does not unreasonably prejudice the legitimate interests 
of the author; and the possibility that a Contracting State may provide, in the case of 
sound recordings of musical works, for a right to equitable remuneration), 

 the right to use the work as a basis for an audiovisual work, and the right to reproduce, 
distribute, perform in public or communicate to the public that audiovisual work. 

When some creation is copyrighted then we understand that all rights are reserved by the 
author. For any use we want to make with its property we’ll need explicit permission of the 
copyright holders. 

Now we find ourselves making a lesson and we want to reutilise content we’ve found in a 
book, or a website, or a video or any other place. What should we check? How should we 
proceed? 

                                                           
1 Copyright article on Wikipedia: https://en.wikipedia.org/wiki/Copyright 
2 Berne Convention - The minimum standards of protection relate to the works and rights to be protected: 
https://en.wikipedia.org/wiki/Berne_Convention 
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Lesson 2: Licensing and Terms of Use 
If the only reference about the licensing terms in the source we’re checking is a “All rights 
reserved”, or the copyright symbol, then we need to ask for permission to the author to reuse, 
modify or distribute any part of it. 

However, the author may have written or referred to a copyright license that his/her work may 
fall under, and such license will explain us how we can use the work in terms of reusing, 
distribution and modification. 

It is impossible not to mention here Creative Commons, a collection of public copyright 
licenses that enable the free distribution of copyrighted work. Most of the open resources are 
licensed under Creative Commons, as their licenses (and the ability to remix their licenses to 
obtain the one that suits us most) cover most of the copyright restriction for the works that fall 
into public domain. 

The rights managed by the CC licenses are: 

 

Attribution (BY) 

You may copy, distribute, display, perform and make derivative works 
only if you credit the original author. 

You get a math book under CC and you decide to update the chapter 
about integrals with better examples. You need to credit the original 
author of the book. 

 

Share-alike 

(SA) 

You may distribute derivative works only under a license identical to the 
license of the original work. You can’t relicense it with more restrictions. 
 

The updated math book needs to have the same license than the original 
(or one with the same restrictions). 

 

Non-commercial 

(NC) 

You may copy, distribute, display, perform and make derivative works, 
but you can’t profit on it. 

You can’t sell the new math book, nor charge anyone for using, 
distributing or modifying it. 

 

No Derivative 

(ND) 

You may copy, distribute, display and perform, but you cannot modify it. 

The maths book will have to keep the original chapters. 

 

Should we license our content with an open license? 
It’s up to you, and how much you want to participate in the community. There are lots of open 
educational resources (OER) available (like the content of this guide, for example), and you 
have to take into account something very important: if you share, you may take, but if you 
don’t share then you can’t take much. That’s how open licenses work most of the time. 
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You can take a look at how compatible are the licenses in the following table3: 

 

 

What about fair use? 
Fair use is the possibility to use copyrighted material for a limited purpose, such as to 
comment, criticise or parody. For example, if we get the paragraph of a book as a citation. 
Now, can we do it? 

Fair use is an established doctrine in the United States, but it’s not under any common legal 
framework in the European Union. Even though some members have special copyright 
exceptions that work similarly to that of fair use, it doesn’t exist in Europe. 

In other words, if the license of the work doesn’t allow us to do it, then we need to ask for 
permission. 

  

                                                           
3 Creative Commons: Can I combine material under different Creative Commons licenses in my work?: 
https://creativecommons.org/faq/#can-i-combine-material-under-different-creative-commons-licenses-
in-my-work 
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Annex I: Moodle tutorial 
Moodle (Modular Object-Oriented Dynamic Learning Environment) is one of the most used 
learning management system in the educative world. As open source software, it allows us to 
adapt it to our needs. 

One of its main advantages reside in its vast community support and its extensible system that 
provides the institutions with a huge amount of resources to adapt and improve their courses. 

Under this section we will observe Moodle from the teacher’s perspective. 

Minimum requirements 
The requirements to access a Moodle platform (from the side of the teachers and students) are 
quite simple: 

 Have an active internet connection 
 Use an updated browser (Microsoft Edge, Google Chrome, Mozilla Firefox) 
 Have a username and password to access the virtual platform 

 
Given these conditions, users should not have any problem to access the resources 
of the e-learning platform. 
 

Navigating through the platform 
The left navigation menu allows for quickly moving 
between the main sections of the platform, such as: 

 Home: the homepage of the platform. 
Usually hosts the course lists and the news and 
announcements. 
 Dashboard: Private area of the user. It 
can be customised to show different aspects of 
the platform (like the calendar or the private 
files). 
 My courses: Courses where the user is 
enrolled (either as teacher or as student). 
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When a teacher is inside of the course, another navigation module will appear called 
Administration. This menu will allow modifying any aspect of the course. 
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Creating and managing activities and resources 
Activities and resources compose the content of the courses. Whether it is a block of text, a quiz, 
a video or a link, every activity or resource is managed from the same place. 

Some of the most common ones are the following: 

Assignment 
Allows the teacher to communicate tasks, collect work and provide grades and feedback. It is 
usually the main tool for grading the students. 

It can ask the students to upload files (like PDF or Word documents), and to add a text 
commentary to it. A deadline can be set under which no more submissions will be allowed. 

Forum 
A common place for the students and teachers to communicate. Usually it is common to have a 
forum for the entire subject, but if the content is very diverse a forum for each section can prove 
to be more useful. 

Glossary 
A list of definitions. Can have images and files attached, and can accept comments from the 
students or other teachers. 

Lesson 
A lesson is composed of several pages with text, images, videos and quizzes. It allows for non-
linear lessons, meaning that depending on the choice of the student it can lead to different path. 
It’s useful to create branching games. 

Quiz 
Enables the teacher to create quizzes and exams with various types of questions, including 
multiple choice, matching, short-answer and numerical. 

File 
Serving a file for the student to download. Usually for content that cannot be seen directly 
through the platform, like PDF or ZIP files. 

URL 
Similar to file, allows the teacher to add a link to another website. 
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To start adding content to the course, the teacher needs to enable the editing mode. For that, 
the option to Turn editing on must be selected. 

 

 

Under editing mode, we can add, edit, reorder and remove the content. To add new content, 
the teacher needs to select to Add an activity or resource. 

 

A new window with the different activities available in the platform will appear, as well as the 
description of it. 
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Enrolling your students 
We can enrol new users in their course through Course administration -> Enrolled users. First, 
the student must exist as a user in the platform.  

 

We’ll find the list of already enrolled users there, and a button that invites us to enrol more 
users. 

 

Where the teacher can assign the role and manually add as many users as needed. 
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Grading the students with the gradebook 
We can automate the evaluation of the students through the Gradebook. The gradebook allows 
setting the weight that each activity will have on the final mark. 

After generating all of the activities that are going to be measured for the grading, the teacher 
can access the gradebook setup from the administration module. 

 

 

By default, the weights are distributed evenly, so that every activity has the same impact 
towards the final mark. We can modify it by checking the checkbox and manually typing the 
weight (as percentages). 
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We can also change the evaluation system by finding the course name in this page (the first line 
of the table) and clicking Edit. 

 

Inside we can change the aggregation of the grades (mean, median, lowest or highest grade, 
etc.) as well as the grade type and the maximum and minimum grade. 

In the case of blended learning where face-to-face exams may happen, we can add its grades 
and weights through the Add grade item button at the bottom. The gradebook will then 
considerate it when calculating the final mark. 

 


